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Overview 
A quick tour of the interface: 

 

1. The initial view of the Geographic Names Search (GNS) application. 

Figure 1 shows the initial view, with a main map window surrounded by menus and widgets. Before 

beginning a tour of these menus and widgets, note the main map. 

Main Map 
The main map supports interaction with several different tools: 

• Three button mouse 

o rolling the mouse wheel forward (away from you) will zoom in the map 

o rolling the mouse wheel backward (toward you) will zoom out 

o clicking and dragging pans the map around 

o a single left click currently has no map-specific functionality 

o a double-click will zoom in the map 

o right-clicks currently have no map-specific functionality 

• Trackpad / touchpad (check your individual computer settings to verify what is or isn’t enabled). 

Note that functionality may differ on a Mac unless you have corrected the factory settings (up is 

down, down is up) for the trackpad 

o clicking and dragging pans the map around 

o a two-finger slide forward (up) zooms in  

o a two-finger slide backward (down) zooms out 

o a two-finger slide left zooms in 

o a two-finger slide right zooms out 

o “pinching”: sliding two fingers away from each other will zoom the map in, while sliding 

them together will zoom the map out 
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• Keyboard 

o the direction keys will pan the map 

o + zooms in 

o – zooms out 

The Main Menu (Figure 1, section 1) 
The main menu contains controls corresponding to the map: 

 

    

The Zoom buttons. The “+” button zooms in, while the “–“ button zooms out. 

 

 

 

The Home button. This returns the zoom level to the default extent. For this application, 

this is the global extent. 

 

 

The Next / Previous Extent buttons. These will pan and zoom to the most recent extent 

before the current one, or to the next one, allowing the user to switch between spots on 

the map to return to (note that this will not persist across sessions, so even a page 

refresh will purge the history) 

 

The GeoNames Soft-Copy Keyboard button. This button opens the regional keyboard, 

allowing the user to type characters with diacritics into the search fields in the 

application. See the full Keyboard Help PDF on the GNS website Services page for more 

details. 

 

The Fuzzy Search button opens the window for “fuzzy” searches powered by the Solr 

engine. 

 

The GNS Links button provides a straightforward way for users to either copy or open a 

variety of useful links such as the GNS Home page and the GNS Portal. 

The Searchable GNS Codes icon directly links to the GNS website Searchable GNS Code 

page. 

The Measure tool allows users to measure the distance between two points. 

 

The Widgets Menu (Figure 1, section 2) 
The widgets menu contains buttons corresponding to the main functions of the application. At this time, 

there are six widgets: 
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The Legend widget displays a legend showing which layers correspond to the various 

symbols on the map. Unless the user adds data from another source, no layers will be 

displayed in the legend. See ArcGIS legend documentation for details. 

 

The Layer List widget. Displays each layer on the map, and provides options to toggle 

each on and off. See ArcGIS layer list documentation for details. This widget displays all 

layers that have been added to the map, whether they are displayed or not, and 

manages their appearance on the map. To the right of each layer is an ellipsis that, 

when clicked, expands a contextual menu that pertains to each individual layer. Each 

layer type will have slightly different options. 

In the GNS application, the Geopolitical Entities layer is turned off by default, but the 

user can turn on this layer by clicking the check box highlighted in Figure 2.  

 

2. The Layer List of the Geographic Names Search (GNS) application. 

Zoom to: zooms to the extent of this layer 

Transparency: applies a transparency to the feature; more effective for polygon features 

Disable (Enable) Pop-up: if the pop-up is enabled, clicking on a feature displays attribute 

information about that feature. Full names for each feature are displayed in the pop-up 

under the heading “full name.” This menu item toggles the availability of the pop-up. 

Move Up / Move Down: determines the drawing order of the layer. If layers overlap, the 

layer on top of this list displays on the top of the stack 

View in Attribute Table: opens the attribute table for this layer 

Description: only applies to ArcGIS map or feature services; displays a description of the 

layer. (Layers from ArcGIS Portal contain a “Show Item Details” menu item instead, 

which is a link to that item’s page in Portal). 

At the top of the widget, just beneath the banner, the phrase Operational Layers can be 

seen, and to its right, an icon of a checkmark with horizontal lines. This menu manages 

all layers at once. It gives the users the ability to: 

▪ Show all layers 

https://doc.arcgis.com/en/web-appbuilder/create-apps/widget-legend.htm
https://doc.arcgis.com/en/web-appbuilder/create-apps/widget-layer-list.htm
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▪ Hide all layers 

▪ Expand all layers: displays the symbol for all layers in the widget 

▪ Collapse all layers: hides the symbol for all layers in the widget 

Each layer in the layer list has an ellipsis to its right. Clicking this ellipsis opens the layer’s 

contextual menu. The menu items vary based on the layer type (points, polygons, map 

tiles, etc.), but the GeoNames features layer’s menu offers the following tasks: 

▪ Zoom To zooms to the selection in that layer. Note that the resulting extent is 

dependent on the layer: zooming to a selection of points will zoom in to those 

points; if a large feature from a polygon layer is also selected, and the user 

zooms to that layer’s selection, the extent will include the entire polygon. It is 

possible for the search app to contain countries that do not have bounding 

coordinates, and therefore are not compatible with the Zoom To functionality. 

▪ Pan To focuses on the selection using the current extent 

▪ Flash will provide a short animation to further highlight the selected feature(s) 

▪ Statistics opens a window displaying summary statistics about  a user-selected 

field (see below) 

▪ Create Layer creates a layer in the user’s portal content containing the selected 

features from this layer 

▪ View in Attribute Table opens the attribute table, showing the selected features 

▪ Clear Selection clears the selection 

 

The Add Data widget. Allows the user to add layers from sources other than the 

Geographic Names Database (GNDB). The tabs at the top of the widget indicate the 

applicable sources: an ArcGIS Portal Item, a URL, or a local file. See ArcGIS add data 

documentation for details. 

When opening the widget, the “Search” tab appears first. By default, the widget shows a 

list of portal items owned by users in the same ArcGIS Portal organization. By clicking 

“My Organization” a menu opens that allows the user to select from Organization 

content, the user’s content, or from ArcGIS Online. Upon changing the source, the list of 

available items changes to reflect the content available to add. The Search text box 

allows the user to search within the scope defined by the aforementioned menu. 

The next section offers filtering options. From left to right, the “Within Map” button 

limits the content list to items whose extent lies within the present map extent. The 

Type filter offers different formats of items: Map Service, Feature Service, Image 

Service, Vector Tile Service, KML, or the open source WMS, or Web Map Service. To the 

right are the sorting options. 

Under the URL tab, the user enters a URL that references a remote resource. Under 

Type, there are options for the source type: an ArcGIS Server service, open source 

service (WMS, WFS, WCS), KML, GeoRSS File, or a CSV file. Entering a valid URL and 

clicking Add will add the item to the map. 

https://doc.arcgis.com/en/web-appbuilder/create-apps/widget-add-data.htm
https://doc.arcgis.com/en/web-appbuilder/create-apps/widget-add-data.htm
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The “File” tab allows a local file from the user’s computer to be uploaded to the map. 

Users may click and drag items or click the browse button to navigate to the desired file. 

At the bottom of the widget, the Layers button allows the user to view all added items. 

  

The Select widget. Allows the user to make selections to the data in the map by drawing 

a bounding box on the map, or to clear an existing selection. The select widget allows 

users to select any features added to the map, highlighting them on the map and 

allowing for records in the attribute table to be filtered. The selection tool uses a user-

defined rectangle to form the selection. This is the widget to use in conjunction with the 

Search Widget’s Selected Features Spatial Filter. 

The Select button is already highlighted, allowing the user to draw the selection box in 

the map upon opening the widget. Clicking the button will remove the highlight and 

deactivate the tool. The Clear button clears any active selection made with this tool. 

 

The Search widget. The Geographic Names Search functionality is contained in this 

widget. This widget is open by default when the application opens. If it closes at any 

point, it may be opened again by clicking this icon. 

 

The Help Documentation widget. This opens the FGMod GeoNames Geographic Names 

Search User Guide 

 

The Contact Us widget. This allows users to submit feedback to the GeoNames team, 

and a contact email so that the GeoNames team can discuss the feedback with the user. 

This form is also available from the GNS website with both audio and visual CAPTCHA.  

 

Matomo opt-out. As part of the privacy policy (which can be found on the GNS website), 

users are given the option to opt-out of the GeoNames website tracking service 

Matomo. Note: this option is only available to users accessing the application from the 

public domain (https://geonames.nga.mil/geonames/GeographicNamesSearch/).  

 

Geographic Names Search Widget Window (Figure 1, section 3) 

To minimize the window, click the up arrows in the window banner:  . This will leave the window 

open and preserve the state of any search that has begun, but clears the main view of the window, 

https://geonames.nga.mil/geonames/GeographicNamesSearch/


Geographic Names Search App User Guide  UNCLASSIFIED  GeoNames Build 2.44-1.0 
 

 Page 8 of 29 
 

except for the window banner. To restore the window, click the corresponding button in the minimized 

window view: .To close the window, click the  button in the window banner. 

 

 

3. The Geographic Names Search widget.  

The Coordinates Pin Widget (Figure 1, section 4) 
This widget displays the coordinates of the cursor on the screen. If the user clicks the crosshairs at the 

left end of the widget, the next click on the map will freeze the coordinate values and a pin is placed on 

the map at the point of the click. Subsequent clicks on the map change the coordinate values and move 

the pin to the location of the most recent click. This option is available in Decimal Degrees, Degrees 

Minutes, Degrees Minutes Seconds, or MGRS coordinates. 

 

4. The Coordinates Pin widget.  
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To change the behavior of the coordinate values back to the default behavior where the coordinates 

change as the cursor moves around the screen, click the crosshairs on the left side of the widget again. 

The Attribute Table Handle (Figure 1, section 5) 
A click on this small handle at the center of the bottom of the screen opens the attribute table. Once 

open, the attribute table for any layer in the map can be displayed, with different layers being 

represented by tabs. To close the table, click the handle again. See more detailed documentation on the 

attribute table for more information. More information on the attribute table is on pages 19-20 of this 

document. 

 

5. The Attribute Table Handle widget.  

 

Geographic Names Search Widget 
Now that we are more familiar with the layout of the application and where each component is, we are 

ready to explore the main component of this application: the GNS widget. 

The widget is divided into three sections: 

• the Names Search 

• Search Filters 

• The Options Menu 

The Names Search 
It is possible to immediately enter a place name to search upon opening the application, but for a faster 

result that returns fewer records, we suggest that searches are constrained with additional parameters, 

such as a country name. Of note: if users try to query the entire GNS (without any constraints), an error 

message will appear to prevent this action. See below for instruction on entering search parameters. 

 

6. The default display of the Name Search in the GNS widget.  

Upon entering a name in the search field, click the + button to add that name to the search terms. The 

name (or name fragment) appears underneath, with some buttons next to it.  

By default, the button is selected, indicating that a name fragment can be entered and the 

Search function will search for any name that starts with the submitted value. For different types of 
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searches for the same value, the , , or buttons can be selected for searches for 

the exact value, for any name containing the value, or for names ending with the submitted value. Note 

that pressing the Tab key does not add the name to the search app. 

To remove the search term from the search, select the X button to the right of the name. 

Multiple search terms can be submitted. Entering in a second term and clicking the + button will add 

that term to the search. Note that each term can contain a different query type: 

 

 

7. The Name Search in the GNS widget once names have been entered.  

 

As each search term is added to the search, the Count increments by one. To clear the search terms, 

press the Reset button: 

 

8. The reset button returns the Names Search to the default display, shown in Figure 6. 

If a name search is entered without a country filter or spatial filter, this may cause the app to slow down 

significantly. To prevent this, the “Names Search Warning” will come up to notify the user that their 

query may take some time to complete. It is possible to perform the query anyway by clicking 

“Proceed,” but the performance of the app may be drastically slowed.  
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9. Name Search Warning when there is no country or spatial filter applied  

When the “Proceed” option is selected in the Name Search Warning, for queries which return more than 

10,000 features, the “Large Query Action Selector” interceptor message displays in the search app to 

minimize long processing times. Instead of waiting to see the query on the web map, users can 

immediately export results. Options include: continue to “Show on Map”, Export as CSV, KML or GIS data.  

When exporting data from the “Large Query Action Selector” interceptor message, you will enter a file 

name.  The underbar special character “ _ ” is allowed in the file name.  Please do not use any other special 

characters, spaces, or leading digits in the name.  Spaces will be converted to underbars, leading digits 

will get an underbar in front, and other special characters will be removed.  

To dismiss the “Large Query Action Selector” message, click Close or click the “x” in the upper right corner. 

 

10. The “Large Query Action Selector” message dialog box 

 

Search Filters 
Below the Names Search section, six filter menus allow the user to provide detail about the scope of the 

search. The note next to the search field suggests entering a country name, but the GNS application 

provides more ways to filter a search. The available types of filters are as following: 

• Country 

• Administrative Divisions 

• Name Type  

• Feature Type 

• Spatial  

• Advanced 
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11. The Country Filter in the GNS Names Search widget. 

Country Filter 
The Country filter contains one text field and some buttons to the right of it. The text field supports 

starts with searches, such that entering one letter is sufficient for the tool to autocomplete the country 

name. To query countries that start with the entered value, type a few letters and select one from the 

dropdown list to select a country. If the query results in one country, that country name will 

autocomplete in the search field. In the example above, “Az” was entered, and “Azerbaijan” is the only 

country that begins with the submitted value. The value to the right changes to reflect how many 

countries the query returns. 

The user may expand the filter row by selecting the  button at the left of the row. The resulting list 

appears below, with counts of the query results per each group: 

 

12. The expanded Country Filter in the GNS Names Search widget. 

Each group can be expanded again to view the countries in that group. All countries are displayed, but 

the results of the query will have checks next to them: 
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13. Selecting countries with the Country Filter in the GNS Names Search widget. 

Once query results are obtained, the user may use the buttons at the right of the row to Reset the 

query, Select All countries the query returns, or Zoom To the extent of the countries the query returns. 

 

When querying based on country, there are options to include or exclude international features. An 

international feature is one that exists in more than one country. For example, the mountain range 

"Alps" exists in Austria, Switzerland, Germany, France, Italy, Liechtenstein, Monaco, and Slovenia. When 

a country filter is applied, international features are included by default. International features are also 

included in queries by default. To exclude international features, un-check the "INCLUDE International 

Features" option. This option will return all features that exist within the selected country or countries, 

including international features. To search ONLY for international features, check the "ONLY 

International Features" option. This option will return only international features that exist within the 

select country or countries. 

 

14. International Features Options 
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Administrative Divisions 
The Administrative Divisions filter relies on the initial limits provided by the Country Filter and allows for 

further filtering. Note that if this menu is opened without first entering a country, the filter will only 

prompt the user to enter a country or countries. 

The menu, upon completion of the country search, can be expanded to reveal an entry for each first-

order administrative division (ADM1) within the selected country or countries.  

 

15. The Administrative Divisions Filter in the GNS Names Search widget. 

Clicking one or more of the checkboxes corresponding to the ADM1 will limit the names search to that 

administrative division. Alternatively, the user may click the button to clear the selection, or the 

 button to select all of the given choices. 

 

Name Type Filter 

 

16. The Name Type Filter in the GNS Names Search widget. 

 

On the left of the Name Type filter, there is a selection box containing the valid name types in the GNDB. 

Selecting one row in the selection box will limit the search results to names of the corresponding name 

type. Multiple selection is supported (Ctrl+click). At the top, on the right, the  

button selects all approved name types when clicked (Conventional, Unverified, Approved, and 

Provisional names).  



Geographic Names Search App User Guide  UNCLASSIFIED  GeoNames Build 2.44-1.0 
 

 Page 15 of 29 
 

Beneath the Approved Name Types button, there are two radio buttons:  

 

17. Close-up of options on the Name Type Filter in the GNS Names Search widget. 

Selecting the former will return only features containing names with the selected name types. For 

example, if Unverified (D) and Unverified Non-Roman Script (DS) are selected, only features with both of 

those types of names will be returned by the query.  

Selecting the latter will return any feature containing at least one of the selected name types. In the 

example above, a search with D and DS selected, any feature containing either will be returned. 

As with the other filters, the Reset button clears the active selection, while Select All will select all of the 

name types. 

 

 

Feature Type Filter 

 

18. The Feature Type Filter in the GNS Names Search widget. 

 

This filter presents a text search box and a hierarchical menu, with values from the available feature 

types, and the designation codes within each feature types. The “Designation Code” and “Designation 

Text” fields are both searchable. Each feature type sub-menu may be expanded to reveal the 

designation codes for that feature type. Note that one may “Select All” or clear the whole selection 

block, or only for one feature class type at a time. 
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Spatial Filter 

 

19. The Spatial Filter in the GNS Names Search widget. 

 

The spatial filter presents several types of filter, each containing its own tab. The “Draw Buffer tools” tab 

allows the user to draw points or polygons, and then select all features in a configurable buffer of the 

user-drawn feature. The “Selected Features Tools” allows the user to buffer a polygon feature to make a 

selection. Since the GNDB does not include polygons, the user must either draw or import a polygon 

feature. The “Bounding Rectangle” tab allows the user to specify a rectangle within which features will 

be selected. The rectangle can be specified in MGRS, GeoRef, DMS, or DD coordinates. The “Radial 

Search” tab allows users to specify a point using coordinates, and a buffer distance within which 

features will be selected. Note that the “Intersect” tool is not available. 

 

Draw Tools  

These tools allow the user to draw a shape on the map window to apply a spatial filter to their search.  

• Rectangle: click and drag to draw a rectangle on the map. When the user releases the button, 

the shape completes.  

• Polygon: allows the user to draw irregular shapes with which to bound the search. The user 

clicks once per polygon vertex and completes the shape by double-clicking. The polygon drawing 

tool is suitable for irregular shapes with straight edges. 

 

20. Draw Tools in the Spatial Filter. 

• Circle: click and drag from the center of the desired area to the edge, and the circle draws on 

the map. When the user releases the button, the shape completes. 

• Lasso: allows the user to draw irregular shapes with which to bound the search. The user clicks 

one to begin the sketch, and the shape follows the cursor as the user traces over the map. When 
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the user releases the button, the shape completes. Suitable for irregularly-shaped AOIs with 

curvilinear contours (i.e., natural boundaries) 

 

 

21. The Lasso Tool in the Spatial Filter. 

 

 

Draw-Buffer Tools 

 

22. Draw-Buffer Tools in the Spatial Filter. 

 

This set of tools accepts as input a user-defined shape of the following types, and a user-defined 

distance (the default is 10 miles). When the user completes sketching the shape, a buffer around the 

given shape is created and the area of interest (AOI) is defined by the buffer. Below, the country of 

Bahrain has been selected from a generalized countries polygon feature service. 

• Point: a single point around which a buffer of the specified distance is drawn. 

• Multipoint: allows the user to input several points, around which a buffer of the specified 

distance is drawn. Double-click to finish drawing points. 

• Line: the buffer draws at the specified distance around a user-defined line. Click and drag to 

define the line. 

• Polyline: allows the user to draw a more complex path using line segments. Every click on the 

map defines the location where the next segment begins. The buffer draws at the specified 

distance around the finished line. Double-click to finish the sketch. 



Geographic Names Search App User Guide  UNCLASSIFIED  GeoNames Build 2.44-1.0 
 

 Page 18 of 29 
 

• Lasso: allows the user to draw an irregular shape; the user clicks to begin the sketch, and as long 

as the mouse button isn’t released, the path continues to draw. The buffer is then drawn at the 

specified distance. 

 

 

23. Polyline Buffer in the Spatial Filter. 

 

24. Lasso buffer in the Spatial Filter. 
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Intersect Tool 

 

25. Intersect Tool in the Spatial Filter, with the select tool circled in red. 

 

The Intersect Tool can be used to select GeoNames point features that intersect with an existing 

polygon selection. Before using the Intersect Tool, use the select tool to first select a polygon or multiple 

polygons. 

 

Bounding Rectangle 

 

26. Bounding Rectangle Tools in the Spatial Filter. 

This allows the user to define a bounding box with numerical coordinates, rather than interacting with 

the map. 
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Radial Search 

 

27. Radial Search Tools in the Spatial Filter. 

This tool allows the user to enter coordinates, or a Unique Feature Identifier (UFI) and a buffer distance 

in order to apply a spatial filter to their search. 

 

Advanced Search Options 

 

28. The Advanced Search Filter in the GNS Names Search widget. 

 

This section provides search filters for users more familiar with the GNDB. The filters in this section 

allow the user to filter by: 



Geographic Names Search App User Guide  UNCLASSIFIED  GeoNames Build 2.44-1.0 
 

 Page 21 of 29 
 

• Generic name: The generic search query uses the “Generic” field, which can be found by clicking 

the “Show Detailed View” in the Attribute Table. The generic attribute is place to capture the 

part of the name that refers to the generic feature type. These generics can – but do not always 

– correspond to the designation code or feature type (e.g., there is a Cerro Teuhtli in Mexico, 

where the generic is “Cerro,” or hill, but the desig_cd is not MT or HLL, it’s VLC/volcano).  

The four options for the generic term search are “Exact”, “Contains”, “Starts” (starts with), and 

“Ends” (ends with).  The “Start” option is the default. The Generic search text box is tolerant of 

diacritics and case.  

o Diacritic Example: bazeu 

▪ Typing “bazeu” in the Generic filter text box and then clicking “Query & Display 

Data” will return “Bazeü Trèz”.  

 

 
o Exact Example: boca 

▪ Typing “boca” in the Generic filter text with the “Exact” option, and then clicking 

“Query & Display Data” will return ~500 records, where the Generic value is 

exactly “Boca”. 

 
o “Generic Starts With” Example: isl 

▪ In Spanish, there are multiple generics for island (isla, islote) and islands (islas, 

isloates). To search for all the features that have a generic value populated with 

some variation of the Spanish words for “island/s”, you can query for “generic 

starts with isl.” 
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• Unique Feature Id(s): (UFI) 

• Modify On or After: Modify date of a feature or name, either on or after. Modified on or after 

includes “mod_dt_ft” and “mot_dt_nm” fields for the input date.  

• Cartographic Usability Range: this parameter indicates the scale of the map necessary for a 

given feature to be seen on it, suggesting a feature’s scale. Choosing a larger value here will 

return features displayed on a map of that scale range. Choosing smaller values will return more 

features, because more features will be shown on maps of that scale range. 

• Romanization System: toponyms written in non-Roman alphabets require a Romanization 

system to convert its characters to their equivalent or approximation in an alphabet using 

Roman characters. This parameter limits the results to those names using the given 

Romanization system 

• MGRS Coordinate: Military Grid Reference System coordinates 

• Language Code: an optional dropdown list of language codes  

o  
• Name Rank: for features with multiple approved names. Certain features may have more than 

one, and the name rank attribute is given to indicate preference. 1 is the highest rank. 

• GIS Notes Required: only searches records with notes associated.  

Pressing the Reset button clears any and all selections made in this section. 

 

 

Options Menu 
At the bottom of the Search widget, the Options Menu contains four buttons, each with a menu inside: 

          

29. The Options Menu below the GNS Names Search widget. 

Query & Display Data 
Clicking this button will initiate the search. Clicking the button expands the menu, offering the following 

options: 
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• Quick Spatial-Filter: clicking this menu item displays a red square on the map, which shrinks or 

grows by rolling the mouse wheel up or down. The extent of this square becomes a spatial filter 

to be applied to the query. 

• Get Feature Count: this returns the count of features that a query with the selected search 

parameters would return. The result is displayed underneath the menu: 

 

30. Query & Display Data: Get Feature Count in the Options Menu. 

• Auto-fill Features: automatically selects all feature types, given the active parameter selections. 

Selecting auto-fill features populates the feature-type filter with the count of each type in the 

query. 

• Show Me My Query: checking the box in this menu item will display the user-selected 

parameters when the Query & Display Data button is clicked. Note that when this option is 

selected, the user is required to confirm their query to initiate it. In the example below, 

“Jersey,” “Jordan” and “Laos” are selected in the country filter (“noHistoric” is a default setting, 

addressed below).  

 

31. Query & Display Data: Show Me My Query in the Options Menu. 

If the query returns more than 10,000 features, an interceptor message will appear before your query is 

run. From this interceptor, the user can download the results directly without displaying them on the 

map. This is recommended for larger queries where processing times may be longer. Tool tips are 

present in all options on this menu. When lower case script names are entered, they are flipped to 

uppercase for the query when case is relevant, and scripts without case are unchanged.  

Historical Options 
Clicking this button expands the historical options menu, which contains the two options, controlled by 

checkboxes: 

• Include Historical Records:  

o includes records that are no longer active 

o includes terminated names and terminated features 

• Historical Records Only:  

o limits the search to records that are no longer active 

o includes terminated names and terminated features 
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Reset All 
Clicking this button clears all search parameters and clears any features displayed on the map. It also 

returns the map extent to the worldwide extent. 

Clicking the Up Arrow at the right of this button expands the menu to include the Clear Map menu item, 

which preserves the search parameters but clears the map of any GNDB features on it. 

Save Search 
The menu resulting from clicking this button allows users to save, import, and export search parameters. 

The expanded menu contains the following options: 

• Activate: this button initializes the Activate dialog, which presents all of the user’s saved 

searches. The user selects one and that search’s parameters are restored. To perform the query 

again, the user still needs to click the Query & Display Data button. 

• Export: this allows the user to export search parameters for use at a later date or by another 

user. To export parameters, create a new search, perform the query, save the search and give it 

a name, then click Export. Exported searches are .json files.  

• Import: allows the user to import saved search parameters. Once the .json is selected in File 

Explorer, click the Saved Search dropdown and choose Activate to perform the query. 

• Delete: initiates a dialog that allows the user to select saved searches to delete. Ctrl + click will 

select multiple queries 

• Delete ALL: allows the user to delete all of their saved searches 

Attribute Table 

 

32. The GeoNames Attribute Table. 

The attribute table displays the attributes for one layer at a time. The user may change which layer’s 

table they view by selecting the appropriate tab at the top of this widget. Selected features are 

highlighted in blue. Note that in the first cell of each row, there may be a + symbol accompanied by a 

number. This indicates that the feature represented by that row contains more than one name. The cell 

can be clicked to expand the row, displaying all names associated with that feature. 

Clicking the gray area to the left of the row will select the feature and name represented by that row; 

multiple selection using the Ctrl + Click method is supported. This column is frozen to the left side of the 

screen; as the user scrolls horizontal across the table, the selection column will still be visible. Users may 

also Shift + Click to select a range of records. Note that when there are multiple names per feature, 

selecting the unexpanded row will select the feature and all names associated with it. To select only one 
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name, expand the grouping and select the specific name row as desired. The feature and name count of 

query results is displayed at the bottom of the attribute table. 

Menu 
Across the top, underneath the layer name, is the widget menu. It contains the following items: 

• Export: This item expands to display a submenu with the following items: 

o export all to CSV 

o export all to GIS data zipfile 

o export all to KML 

o export to GeoJson 

o export to OpenStreetMap 

Note that for two options – export to GeoJson and export to OpenStreetMap – there is a feature 

limit of 3000 records. These two formats are not available when features in the table are 

selected; to export to either of these formats, clear the selection using the attribute table menu 

(see below). 

• Filter by Visible Extent: Limits the rows in the table to those within the present visible extent 

(i.e., not including the extent covered by the attribute table) 

• Zoom To: Zooms to selected features 

• Clear Selection: Clears the active selection 

• Refresh Data: Updates the table to include recently added or modified features 

• Reset Data and Columns: Restores any changes made to the table 

• Show Detailed / Show Simple View: Toggles whether to show all columns or an abbreviated 

selection of columns. At the far right of the table view, where the columns are displayed, is a 

small . Clicking this displays a scrollable list of columns with checks next to them. These boxes 

control column visibility. 

• Show / Hide columns: allows the user to hide columns in the attribute table 

• Show Selected records: limits the rows in the table to selected records. Once this is selected, 

this same item toggles the view back to show all rows 

 

33. The GeoNames Attribute Table can be customized to only show certain fields. 
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Fuzzy Search 
The Fuzzy Search capability leverages a Solr engine to return names given approximate or incomplete 

search terms. The fuzzy search can be accessed in the search app in two ways: on the left side of the 

screen, and within the Geographic Names Search widget.  

 

34. Accessing Fuzzy Search 

Once either of these buttons is clicked, the Fuzzy Search widget opens within the GeoNames search app. 

The Fuzzy Search widget is divided into three sections: Basic Search, Fuzzy Search, and Advanced search. 

All three leverage Solr to return names. Users can switch between the three search types using the 

menu in the top left corner of the widget. 

 

35. The Fuzzy Search widget 
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Basic Search 
The basic search has only one free text field. Enter a search term and press “Enter” to return names. The 

names return can either be an exact match or a “fuzzy” match, matching only part of the search term. In 

all searches in the Fuzzy Search widget, wildcard searches are supported. The “?” character can replace 

one character, while the “*” character can replace multiple characters. For example, when looking for 

the capital of Iceland, search terms “reykja*” and “reykjav?k” will both return the city of Reykjavik. The 

number of records displayed by the widget can be changed by the user using the “Num Rows” 

dropdown. The default value is 100. Once names are returned, the user can select some or all of the 

records, and export them in a variety of formats. When the data are downloaded, a .zip folder 

containing the data in the specified format, the GNS Data Dictionary, a GeoNames disclaimer, and a 

dictionary of terms related to the downloaded data.  

 

36. Export records from Fuzzy Search 

Fuzzy Search 
The fuzzy search can be accessed through the menu in the top left corner of the widget. Like the Basic 

search, there is only one free text field. The “Fuzzy Factor” allows the words in the search term to be 

transposed. The “Heavy Fuzz” option will transpose the search term more than the “Light Fuzz” option. 

The “Heavy Fuzz” option will likely return more names than the same search term using the “Light Fuzz” 

option.  
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37. How to access different search methods in Fuzzy Search 

In all searches in the Fuzzy Search widget, wildcard searches are supported. The “?” character can 

replace one character, while the “*” character can replace multiple characters. The number of names 

displayed in the results can be changed the same way as basic search, and names can be selected and 

exported in the same way as basic search. Click “RESET” to clear the widget of all data. 

Advanced Search 

 

38. The Advanced Fuzzy Search 

The “Advanced Search” option leverages multiple free text fields that can be given designations of 

importance in the overall search. This menu can be collapsed or expanded by clicking the button directly 

to the right of the search term. These designations are:  

• Required: These terms will be included in every result of the search. If the name does not 

include this term, it will not be returned in the search.  

• Not: Clicking “Not” is the opposite of clicking “Required.” This function excludes the term from 

any search result.  

• Boost: this designation increases the priority of this search term in the order in which results are 

displayed. The Solr engine prioritizes words by default; users can change these priorities using 

the “boost” designation. 

• Fuzzy: Clicking the fuzzy designation increases the amount this term will be transposed in the 

search results. Approximations of this term will appear in search results.  
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• Ignore: an easy way to remove a search term and re-add it without deleting it from the search. 

Clicking “Ignore” instructs the Solr engine to skip that term while searching the GeoNames 

database.  

In all searches in the Fuzzy Search widget, wildcard searches are supported. The “?” character can 

replace one character, while the “*” character can replace multiple characters. The number of names 

displayed in the results can be changed the same way as basic search, and names can be selected and 

exported in the same way as basic search. Click “RESET” to clear the widget of all data. 

Filter Options and “Locking” filters 
In all three types of Fuzzy search, users are able to further filter their results by “locking” filters in the 

Filter Options dialog.  

 

39. The Filter Options dialog 

After a search has been executed, results are broken down by Country, ADM1, and Feature Type in the 

filter options dialog. Users can further refine the results by clicking the box to the left of each country 

name, ADM1 name, or feature type name. The “Lock Selection” checkbox allows users to filter based on 

more than one of these options. Once one filter is locked, the remaining filters break down the search 

results for only the results still remaining after the filter. For example, if a search returns names in five 

different countries, users can select one country, then lock the selection. The ADM1 filter and feature 

type filter will then only show results in the selected country.  


